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Chapter 1 Introduction

This chapter includes:
Section 1: Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Section 2: Documentation Conventions . . . . . . . . . . . . . . . . . . 10

Section 3: Acronyms and Abbreviations . . . . . . . . . . . . . . . . . . 10

Section 1: Overview

The most important part of the planning process is getting feedback 
from external participants to develop a better understanding of 
demand. Sharing information and managing Exceptions is the key to 
developing a productive relationship with customers and suppliers to 
develop a demand-driven supply chain. The Planning Portal provides 
the foundation for capturing input to take the planning process to the 
next level. It is directly integrated into the Demand Management 
Engine so existing configurations are leveraged to a maximum 
benefit.
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Chapter 1
The figure below is a depiction of the Atlas Planning Suite. The 
Planning Portal encompasses the products of the suite.

1-1: Planning Portal Highlights

 Supports different Views, including hierarchies

 Makes changes to the forecast

 Add Sales Promotions

 Add New Item(s)

 Retag Items (Item super cession)

 Add or Edit Notes

1-2: Logging In

To access the Planning Portal Admin Tool, go to:

Start > Programs > JGS - Atlas Planning Suite > Planning Portal 
> Planning Portal Admin Tool
Rev 1 8
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You must have a username and password to log into the tool. 

You can change your password in the Base Unit when you log in.

Note: Usernames and passwords are case-sensitive.

1-3: Logging Out

If you would like to log out of the application, just close the application 
and remember that if you got a message to restart IIS you will need to 
restart IIS (Internet Information Services) before those changes come 
into effect.

Table 1-1: Default Username and Password

Log In Password

Username fxadmin

Password fxadmin
Rev 1 9
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Section 2: Documentation Conventions

2-1: Text 

Table 1-2: Text Convention Descriptions 

Convention Description

Text represented as a screen display. This typeface represents displays that appear on your 
terminal screen, for example:

lom>

Text represented as menu or sub-menu 
names.

This typeface represents all menu and sub-menu 
names within procedures, for example:
On the File menu, click New.

The following table lists text conventions in this user guide.

2-2: Screen Captures

The example screens in this guide may not represent what you see 
on your monitor; use them only as guidelines.
Rev 1 11
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Chapter 1
Section 3: Acronyms and Abbreviations

Table 1-3: Acronyms and Abbreviations used in this Manual

Term Definition

DME Demand Management Engine

PP Planning Portal

DB Database

IIS Internet Information Services

OL Opinion Line
Rev 1 13



Chapter 2 Installation

This chapter includes:
Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Section 2: Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Section 3: Prerequisites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Section 4: Upgrading from an Older Version of the Planning Portal . . 21

Section 5: DME Admin Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Section 6: Installing the Planning Portal . . . . . . . . . . . . . . . . . . . . . . . 24

Section 7: Miscellaneous Installation Configurations  . . . . . . . . . . . . . 39

Section 1: Overview

This chapter details the installation procedure for the Planning Portal 
application. Please follow the instructions carefully to ensure a successful 
installation.

The following chart shows the architecture of the Planning Portal and the 
software requirements.
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Chapter 2
Section 2: Requirements

As mentioned above, the installation process for the Planning Portal is 
automated. However, there are certain hardware and software 
requirements necessary to ensure the application installs successfully.

2-1: Hardware

The list below details the required hardware to install the Planning Portal.

Table 2-1: Database Server Hardware Requirements 

Hardware Minimum Recommended

CPU Dual 850 MHz Pentium III Quad 2.2 GHz Xeon 
Processors

RAM 2GB RAM 4GB RAM

Hard Disk Ultra SCSI - II, RAID 5 
hard drive controller.

One to three 36GB Hard 
Drives

Ultra SCSI - II internal and 
additional RAID 5 Hard 
Drive controller.

Mirrored volume for 
system and temp files 
(36GB each drive).

Two RAID 5 Data volumes 
with three drives minimum 
(36 GB each drive).

Table 2-2: Web Server Hardware Requirements

Hardware Minimum Recommended

CPU Dual 850 MHz Pentium III Quad 2.2 GHz Xeon 
Processors

RAM 2GB RAM 4MB RAM
Rev 1 15
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Note: The PP Admin Tool has to run on the same computer where the 
Planning Portal was installed. Since the Admin Tool changes the 
settings defined in web.config file (Planning Portal configuration file), 
this needs to be executed locally in the Web Server where the PP is 
installed.

Hard Disk Ultra SCSI - II, RAID 5 
hard drive controller.

1 - 3 36GB Hard Drives

Ultra SCSI - II internal and 
additional RAID 5 Hard 
Drive controller.

Mirrored volume for 
system and temp files 
(36GB each drive).

One RAID 5 Data volumes 
on separate controller 
channels with 3 drives 
minimum (36 GB each 
drive).

Table 2-2: Web Server Hardware Requirements

Hardware Minimum Recommended

Table 2-3: Client Machine Hardware Requirements

Hardware Minimum Recommended

CPU Pentium III - 500 MB Pentium IV- 2.0 GB
Pentium M - 1.2 GHZ

RAM 256 MB 512 MB

Hard Disk 10G 10G
Rev 1 16
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2-2: Software Media

2-2-1: Database Server

 Windows 2003 or 2008 Server. The most current Service Packs 
are highly recommended.

 SQL Server 2005 or 2008 (the most current service packs are 
highly recommended). If SQL Server is not installed, the Demand 
Management Engine provides the option to install SQL Express 
Edition instead.

2-2-2: Web Server

 Windows 2003/2008 Server. The most current Service Packs are 
highly recommended.

 IIS 6.0 or greater

 .NET Framework 3.5 (with SP1)

 .NET Framework 2.0 (with SP2)

 ADO 2.8

 Installer 3.5 (SP1)

 Microsoft Excel Primary Interop Assembly (PIA). Must match 
Office version.

2-2-3: Client Machine

 Windows XP/Windows Vista

 Office 2003/2007/2010 (if you want to export to Excel)

 Internet Explorer 7.0/Internet Explorer 8.0.

Note: You can download and install .NET 2.0, ADO 2.8, and Installer 3.1 
from www.microsoft.com.
Rev 1 17
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Section 3: Prerequisites

The list below details the prerequisites prior to beginning the installation.

 IIS 7.0 or greater

 Windows Installer 3.5 SP1

 Microsoft .NET Framework 3.5 SP1

 Microsoft .NET Framework 2.0 SP2

 Internet Explorer 7 / Internet Explorer 8 (with compatibility mode 
enabled)

Note: If IIS is not on the Web Server, but .NET Framework 2.0 already is, 
you must do the following:

 Install IIS. Go to the DOS prompt and change the directory to:

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727>

 Run the following command:

"C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727>aspn
et_regiis -i"

For a 64-bit version operating system:

 Install IIS.Go to the DOS prompt and change the directory to:

C:\Windows\Microsoft.NET\Framework64\v2.0.50727\

 Run the following command:

"C:\Windows\Microsoft.NET\Framework64\v2.0.50727\>a
spnet_regiis -i"
Rev 1 18
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3-1: Microsoft .NET Framework 2.0 (Service Pack 1)

You must verify that ASP.NET 2.0 can run on the web server; this can be 
done by finding it in web server extensions.

1. Go to My Computer > Program Files > Windows > Internet 
Information Services (IIS) Manager.

2. Click on “Web Service Extensions” under your computer.

The Web Service Extensions window displays to the right as shown 
below.

3. Right-click on “ASP .NET v2.0 50727” and select “Allow in the 
window”.

4. Close the window when finished.

3-2: Configure a JSE as MIME Type

To configure a JSE as a MIME Type:

1. Go to My Computer > Program Files > Windows > Internet 
Information Services (IIS) Manager.
Rev 1 19
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2. Right-click on the SERVERNAME (local computer) node.

3. Click on Properties.

4. Click the MIME Types button.

5. Click New to add entry.

6. Enter “.jse” in the extension textbox (no quotes).

7. Enter “application/x-javascript”.

8. Click OK to close the dialog box.

9. Click OK to close the Property dialog box.

10. Right-click on the SERVERNAME (local computer).

11. Select All Tasks.

12. Click Restart IIS… to apply the changes.

3-3: Client Computers

Client computers require the following software media to ensure the 
Planning Portal is used optimally:

 Microsoft Internet Explorer 7.0 or Internet Explorer 8.0.

 Macromedia Flash plug-in for Internet Explorer.

3-4: Other Prerequisites

To upgrade the PP database you need the system administrator (sa) 
account password for the SQL instance being upgraded.
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Section 4: Upgrading from an Older Version of the Planning 
Portal

This section describes upgrading the PP to a newer version. and the 
necessary steps to do this.

Note: If you plan on upgrading the PP but keeping all your existing 
configurations, you need to make sure to save the following files: 
web.config, CustomSettings.xml and Locale.xml. These files are located 
in the folder where the PP was installed. This version of the PP can 
upgrade configurations files from version 3.6.04.26 and higher only; 
backup the current data and settings if you try to move to this version from 
any version lower than the mentioned above.

1. Remove the current version of the Planning Portal.

Start > Control Panel > Add/Remove Programs.

2. Select Atlas Planning Suite - Planning Portal.
Rev 1 21
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The Add/Remove Programs window displays.

3. Click Uninstall. You will be prompted to confirm the uninstall request.

4. Click Yes.

5. Click Yes.

6. Install the latest version of the Planning Portal as detailed in Section 
6: Installing the Planning Portal.

Note: When performing a new installation, the installer deletes all user 
permissions, license key, and custom settings.

Note: Field Views and Data Views created in earlier Planning Portal 
versions do not work in the new version. The migration process 
needs to be done manually.
Rev 1 22
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Section 5: DME Admin Settings

You must edit the Living Master scenario that is to be used with the 
Planning Portal.

1. Log into the DME Admin Tool.

2. Click the Scenarios button in the toolbar.

The Scenario Manager window displays.

3. Select the scenario to use from the Scenario List in the left panel.

The Scenario details display in the Scenario Editor panel at the right.
Rev 1 23
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4. In the Properties panel of the Scenario Editor, click the “User Field 
Settings” tab.

5. Enter or select “WebForm” in User Field 2. This makes the scenario 
available in the Planning Portal. Only scenarios that have this 
property set and are Living Master scenarios will be available in the 
Planning Portal.

6. Click Save.

7. Close the Scenario Manager.

Section 6: Installing the Planning Portal

This section details how to install the Planning Portal successfully.

Note: The Planning Portal installer cannot be installed from a network drive. 
For security reasons, .NET Framework does not allow an .exe file to 
run from a network location. The Planning Portal installation files 
need to be copied locally to the computer where the application will 
be installed.

6-1: Installation Options/Architecture

There are two different ways to install the Planning Portal. Depending 
upon your network configuration, you can install the application on either 
one server or two.
Rev 1 24
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The illustration below depicts the two ways to install.

6-2: Prerequisites

The list below details the prerequisites prior to beginning the installation.

 Demand Management Engine installed.

 A Living Master Scenario (or a default DTL Scenario).
Rev 1 25
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6-3: Installation Process

1. Get the Installation files for the Planning Portal v6. If the file you have 
is a .zip of .rar file make sure to un-compress the files before installing 
them.

2. Click on the Setup.exe file.

The Planning Portal Installation window displays.

3. Click Next.
Rev 1 26
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The Planning Portal License Agreement window displays.

4. After reading the agreement, select the “I accept the terms in the 
license agreement” radio button and click Next. Otherwise, click 
Cancel to quit.
Rev 1 27
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The Customer Information window is displayed

5. Enter your User Name and Organization name in the respective 
fields and click Next.
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The Setup Type window is displayed:

6. There are two types of installations for the Planning Portal, the 
“Complete” option will install all the available components and the 
“Custom” option allows you to select which components to install. The 
following table describes the different components that can be 
installed for the Planning Portal:

Component Description

Database Administration 
Tool

This component updates the Planning Portal 
Database to the latest version as well as 
installing necessary components for the DB 
Server.

Planning Portal This component contains the actual files to 
install the Planning Portal in a web server.

You will probably want to use the Complete option when your Web 
Server and SQL Server are on the same computer, and the Custom 
option when your SQL Server and Web Server are different servers, 
this way you will be able to only install the Planning Portal component 
Rev 1 29
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in the Web Server and only the Database Administration tool in the 
SQL Server.

If you run a Custom install, you will be prompted with the following 
screen to choose the components to install:

7. Click Next to continue the install. If you select the Planning Portal 
component or a Complete install continue to Step 8; if you only 
selected to install the Database Administration Tool, skip to step 10.

8. The following screen is the Installation Address. Here you can choose 
certain options for the Planning Portal component installation:
Rev 1 30
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These settings are related to IIS; you are able to setup the Site under 
which to install the Planning Portal, the name of the Virtual Directory and 
the Application Pool the Planning Portal will be associated with. Unless 
you are familiar with these settings use the defaults and click Next.

9. The Ready to Install screen will be displayed, if you are sure your 
settings are correct just click Install to continue.
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10. If the Database Administration Tool component was selected you will 
be prompted with the following screen:
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In this screen you must provide the information to be used to connect 
to the database including Server Name, Database Name and SQL 
User account and Password to connect to the database.

When performing upgrade on the database the system administrator 
account (“sa”) should be used always. For regular operations for the 
Planning Portal you can change the SQL account used in the PP 
Admin Tool.

The Excel file path is the path to a file used for the promotions 
feature, If you are not planning on using this feature the default value 
is fine.

 Month-Week.xls - if your Promotions are run weekly.

 Week-Day.xls - if your Promotions are run daily.

After all the database related information is input you can test your 
connection by clicking the Test Connection button. If the test is 
successful, click the Upgrade Database button to begin the process.
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The following window displays while running the upgrade.

When the process is completed you will see the following message

11. Click OK.
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If you chose to install the Planning Portal component or a Complete 
Installation option, the Planning Portal Setup window displays. You 
can configure the Administration Utility now or at a later time. 

12. Click OK to launch the Administration Utility, the PP Admin Tool.

Note: To configure and customize the Planning Portal later, the 
Administration Tool can be found at Start > All Programs > JGS - 
Atlas Planning Suite > Planning Portal > Planning Portal Admin Tool.

13. The PP Admin tool is launched next, you can now start making 
changes to your PP installation, import old settings or install a license; 
you can find more information on how to install a license in the 
following section.
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14. After saving your changes and closing the PP Admin Tool you will 
have the PP Release Notes file open in your browser and you will see 
the following screen. The installation is now complete.

6-4: Planning Portal License

To begin using the Planning Portal, you must create a random serial 
number and a license key, which is provided by QAD Inc. 

To generate your serial number:

1. Go to Start > All Programs > JGS - Atlas Planning Suite > 
Planning Portal Admin Tool.

The PP Admin Tool displays.
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2. In the Planning Portal Manager in the left-hand pane, go to Security 
and click “License Generator”.
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3. Click Generate to generate a random serial number.

4. Click Copy to copy the serial number to your clipboard and send the 
serial number to QAD support. You must contact QAD
 for a license key.

When you receive the license key, repeat 
steps 1 and 2 and paste your license key in the License field.

5. Go to File > Save to save your serial number.

6. Close the Admin Tool.

Note: If for whatever reason the license for the PP becomes invalid when 
trying to save a new one you will need to generate a new random 
serial number.
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Section 7: Miscellaneous Installation Configurations

The sections below detail additional configurations for installing the 
Planning Portal successfully.

7-1: Using .NET 2.0

Ensure the Planning Portal is using .NET 2.0.

1. Open Internet Information Services.

2. Right-click on the Planning Portal virtual directory or the virtual 
directory that is used by the Planning Portal.

3. Click on “ASP.NET”.

4. Verify that .NET 2.0 version is selected. If not, select Version 2.0 from 
the drop-down.
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7-2: Write Access to the Planning Portal’s Physical Directory

To enable Write access, you must select the Write permission to the 
Network Service account in the security properties of Planning Portal's 
physical directory. 

1. Go to Planning Portal > PP Installation > App.

2. Right-click on “PPsetup.exe” and select “Properties”.

The PPSetup.exe Properties window displays.

3. Select the user you want to grant write access and click on the Allow 
checkbox.

4. Click Apply and then click OK.
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7-3: Setting Up Integrated Windows Authentication

The Planning Portal is designed to authenticate users either with Planning 
Portal Authentication or with Windows Integrated Authentication. The 
Windows Integrated Authentication feature depends on a similar setting 
of Internet Information Services.

To enable Windows Integrated Authentication:

1. Open Internet Information Services (IIS) Manager.

Start > My Computer > C:drive > Windows > IIS 
Manager.

2. Right-click the Planning Portal virtual directory and select 
“Properties”.

The PlanningPortal Properties window displays.
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3. Select the Directory Security tab and click the Edit button in the 
“Authentication and access control” area.

The Authentication Method window displays.

4. Uncheck the “Enable anonymous access” checkbox and check the 
“Integrated Windows Authentication” checkbox.

5. Click OK and close the window.
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7-4: Excel 2003 Primary Interop Assembly

The Excel 2003 Primary Interop Assembly (PIA) is a required DLL that 
enables the Planning Portal to send data and charts to Microsoft Excel. 
The PIA must be installed on the Web Server if you want to export data to 
Excel in the Classic View.

The primary interop assembly is not installed when performing a default 
installation of Microsoft Office; a custom installation is required to install it. 
Below is an example on how to enable this component while installing 
Microsoft Excel 2003, a similar procedure should be followed when 
installing Office 2007 or Office 2010:

1. Start the Microsoft Office 2003 Install Wizard and click through the 
default selections until you reach the Type of Installation window 
dialog step.

2. Select “Custom Install” and click Next.
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The Custom Setup window displays.

3. Select “Choose advanced customization of applications” and click 
Next.
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The Advanced Customization window displays.

4. Expand the Microsoft Office Excel subtree and include .NET 
Programmability Support as a component to be installed. 

5. Click Next.

6. Click Install in the next window and proceed with the default settings 
installation.
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7-5: Enable the Planning Portal to Launch Microsoft Excel on 
the Server

Note: This procedure only applies to Windows Server 2003 installations that 
include Windows Server 2003 Service Pack 1.

1. Go to Control Panel > Administrative Tools > Component 
Services.

The Component Services window displays.

2. Browse to Component Services > Computers > My Computer > 
DCOM Config.
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3. Click on “DCOM Config”.

4. Scroll down until you find the “Microsoft Excel Application” node.
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5. Right-click the Excel node and click “Properties”.

6. Select the Security tab and select the “Customize” option under 
Configuration Permissions.

7. Click the Edit button.

8. In the Change Configuration Permission window, add the following 
two accounts: ASPNET and Network Service (or the account under 
which the Default Application pool is running) and grant it “Full 
Control” permissions; this applies for Windows XP and Windows 
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2003 Server. For Windows 7 or Windows 2008 Server you must add 
the local Everyone account and give it Full Control.

9. Click OK to save the permission changes and exit.

10. Select the Security tab and select the “Customize” option under 
“Launch and Activation Permissions” and “Access 
Permissions” section.

11. In the Launch Permission window, add the following two accounts: 
ASPNET and Network Service (Or the account under which the 
Default Application pool is running under) and check the “Local 
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Launch” and “Local Activation” permissions under the Allow 
column.
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This chapter includes:
Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
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Section 4: View By  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
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Section 7: Mass Adjust . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Section 8: Promotions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Section 9: Formula Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Section 10: Profile Forecast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Section 11: Miscellaneous. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Section 12: Locale Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Section 13: Tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Section 1: Overview

The features detailed in this chapter are displayed from the Custom 
Settings > Settings feature in the Planning Portal Manager in the left-hand 
pane.
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Section 2: Admin Tool at a Glance

The Admin Tool enables you to configure and customize the Planning 
Portal for end-users. The window below is the main page of the Admin 
Tool.

The following table details briefly each tab and the features of the 
Planning Portal Manager in the left-hand pane.

Table 3-1: Admin Tool tabs

Tab Description

Filter Determines which fields are going to be used for filter 
definition in the Aggregate Report and Mass Adjust 
features.

View By Determines which View By fields are available.
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Aggregate 
Report

For Opinions, determines which Opinion Lines are 
used in the Aggregate Report.

New Item Link Determines which fields are used when creating a new 
item.

Mass Adjust Determines which Opinion Lines are used in the Mass 
Adjust.

Promotions Determines the configuration in Promo Note for both 
Promo Search By and Item.

Formula Input Determines which formulas can be used in the Data 
Browser.

Profile Forecast Determines which Opinion Lines are affected in the 
Profile Forecast.

Miscellaneous For DB connection, determines the type of database 
connection is used. For Round Mode, determines how 
a number will be rounded. For Decimal Pt, provides 
how many decimal points for the data. For Other, 
provides additional information for data.

Locale 
Configuration

Determines the language for text, images, and labels.

Table 3-1: Admin Tool tabs

Tab Description
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Section 3: Filter

Filters provide the ability to select items based on series attributes, as 
well as provide users the ability to manage, control and identify forecasts. 
The Filter tab enables you to determine which fields are used for the Filter 
definition in the Aggregate Report and Mass Adjust features.

The table below details the types of configurations that can be used:

Configuration Description

Column Search Attributes that can be used for the filter.

Column Display Description of the Attribute.

Control Type There are three types of controls:
 Multiple - multiple selection capability.
 Single Editable - choose a field from the list or type 

in the search criteria.
 Text Box - ability to type in the search criteria.
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3-1: To Add a Filter

1. Click the  button.

A new row is added at the bottom of the list.

3-2: To Delete a Filter

1. Click on the Delete checkbox next to the field and click on the 

 button.

The row is deleted from the list automatically.

Control Type 
Others

There are two types of fields:
 List Box - drop-down list of available options.
 Web Combo - combination of drop-down and text 

box options.

Configuration Description
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Section 4: View By

The View By tab enables you to multiply the Opinion Lines by a 
conversion factor. 

The table below details the type of configuration that can be used:

4-1: To Add a Field

1. Click the  button.

A new row is added at the bottom of the list.

Configuration Description

Column Names of Opinion Lines that can be used as a 
conversion factor.

Currency Used to select the financial currency in which the 
Column value is displayed.
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4-2: To Delete a Field

1. Click on the Delete checkbox next to the field and click on the 

 button.

The row is deleted from the list automatically.
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Section 5: Aggregate Report

5-1: Report Level

The Report Level tab determines which fields are displayed in the Report 
Level. 

The table below details the type of configuration that can be used:

Configuration Description

Column Determines which fields are displayed in the Report 
Level.
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5-1-1: To Add a Field

1. Click the  button.

A new row is added at the bottom of the list.

5-1-2: To Delete a Field

1. Click on the Delete checkbox next to the field and click on the 

 button.

The row is deleted from the list automatically.

5-2: Opinions

The Opinion tab determines which Opinion Lines are displayed in the 
report. You can have up to eight Opinions Lines listed.
Rev 1 59



Chapter 3
The table below details the type of configuration that can be used:

5-2-1: To Add an Opinion

1. Click the  button.

A new row is added at the bottom of the list.

5-2-2: To Delete an Opinion

1. Click on the Delete checkbox next to the Opinion Line and click on the 

 button.

The row is then deleted from the list automatically.

Configuration Description

Column Determines which Opinion Lines are displayed in the 
report.
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Section 6: New Item Link

The New Item Link tab determines which fields are used for the New Item 
Creation feature.

The table below details the types of configurations that can be used:

Configuration Description

Column Determines which fields are displayed in the New Item 
feature.

Control There are three options:
 Drop Down - enables you to select from a list of 

what is already in that field.
 Text Box - enables you to enter information directly 

into that field.
 Web Combo - combination of Drop Down and Text 

Box options.

Use In 
Description

Determines whether or not the field is used in the 
description of the new item.
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You can organize the fields to display in a certain order.

1. Select one of the fields in the list.

2. Click on the  or the  
buttons.

The row is then moved up or down, respectively, in the list.

6-1: To Add a Field

1. Click the  button.

A new row is added at the bottom of the list.

6-2: To Delete a Field

1. Click on the Delete checkbox next to the field and click on the 

 button.

The row is deleted from the list automatically.

Default Value This is the value selected by default.

Data Type Determines if the field is a numeric or alpha-numeric 
value.

Configuration Description
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Section 7: Mass Adjust

The Mass Adjust tab determines which Opinion Lines are used in the 
Mass Adjust feature.

The table below details the types of configurations that can be used:

7-1: To Add an Opinion Line

1. Click the  button.

A new row is added at the bottom of the list.

Configuration Description

Column Determines which Opinion Lines are displayed in the 
mass adjust.

Selected Check if the Opinion Line is selected by default.
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7-2: To Delete an Opinion Line

Click on the Delete checkbox next to the Opinion Line and click the 

 button.
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Section 8: Promotions

8-1: Promo Search By

The table below details the types of configurations that can be used:

Configuration Description

Column Search Selects which column to search.

Column Display Indicates description for the column displayed.

Customer 
Account Number

Displays customer account number.

Company 
Number

Displays company ID number.
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8-2: Grid Promo Items

The table below details the type of configuration that can be used:

Configuration Description

Name Three columns of Attributes that are used in 
combination to uniquely identify a series.

Physical Name Sql statement to return labels for the Attributes. 
(Advanced)
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8-3: Item

The table below details the type of configuration that can be used:

Configuration Description

Field Name Field that holds the item code.
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Section 9: Formula Input

The table below details the types of configurations that can be used:

9-1: To Add a New Formula Row

1. Click on the  icon. 

A new row is added to the bottom of the list. To create a formula for 
this new row see the “To Edit an Existing Formula Row” on page 69 
section.

Configuration Description

Target Field Determines where the results are displayed.

Definition Determines the text of the formula (i.e., A = B + C; A= 
Target Field, B+C = definition)
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9-2: To Delete an Existing Formula Row

1. Click on the Delete checkbox next to the formula and click the 

 button.

The row is deleted from the list automatically.

9-3: To Edit an Existing Formula Row

1. Click on the text box you would like to edit.

The Edit button displays in the text box

2. Click the  button.
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The Formula Editor displays.

3. From the Add Series drop down, select the series you would like to 
edit.

4. Make your edits as necessary.

5. Click the  button.

6. Click OK when finished.

Note: The PP Admin Tool allows negative values to start in the formula, but 
the Planning Portal does support it. The following work around can be 
used:

(UserValue01 - UserValue01 - UserValue01) = -UserValue01
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Section 10: Profile Forecast

The Profile Forecast feature enables you to apply a predefined lifecycle 
curve to data. This feature is configured in the DME Viewer.

The table below details the types of configurations that can be used:

10-1: To Add a New Row

1. Click on the  icon. 

A new row is added to the bottom of the list. To create a formula for 
this new row see the “To Edit an Existing Formula Row” on page 69 
section.

Configuration Description

Name Select the Opinion Line to be used.

Selected Select if the Opinion Line is selected by default.
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10-2: To Delete an Existing Row

1. Click on the Delete checkbox next to the formula and click the 

 button.

The row is deleted from the list automatically.
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Section 11: Miscellaneous

11-1: Database Connection

The Database Connection tab details the configuration for the database. 

You can test the database connection by clicking the  
button.

The table below details the types of configurations that can be used:

Key Description

User ID Database user’s Username

Password Database user’s Password

Data Source Database server name

Connect Timeout Amount of time system attempts to connect before 
disconnecting.

DataBase Database name
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11-2: Round Mode

The table below details the types of configurations that can be used:

Pooling Select if you would like to share connections between 
users (Recommended) (Advanced).

Key Description

Configuration Description

Key Each Opinion Line listed.

Value  None - Provides the value to the nearest whole 
number.

 Ceil - Rounds up number to the next whole number.
 Floor - Rounds down number to the next whole 

number.
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11-3: Decimal Point

The table below details the types of configurations that can be used:

Configuration Description

Key Each Opinion Line listed.

Value Number of decimal points displayed.
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11-4: Others

The table below details the types of configurations that can be used:

Key Description

CurrencyDriven Effected by currency.

NoViewByIn Determines which fields are not affected by View By 
(conversion factor).

Rebalance Causes changes to be distributed throughout if there is 
a hierarchy.

StoreChangeInfo Determines if changes are to be tracked.

SCDateField Field in series that holds the date when changes were 
made.

SCUserField Field in series that holds the username who made the 
changes.

CustomTaskOn
Update

Enables execution of the custom code when data 
changes (Advanced).
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LockedPeriodOff Disables the lock of certain fields from the last locked 
period.

FrozenColumn 
Count

Number of columns frozen in Detail or Classical views.

Logo Home 
Page Path

Enables you to customize your company’s logo for the 
Getting Started page.

Microsoft.Office. 
Interop.Excel

Enables users to export data to Excel in Detail View 
from the Data Browser.

Classic View 
Enabled

Radio buttons used to determine if the Classic View is 
enabled in the Planning Portal.

Summary View 
Enabled

Radio buttons used to determine if the Summary View 
is enabled in the Planning Portal.

Detail View 
Enabled

Radio buttons used to determine if the Detail View is 
enabled in the Planning Portal.

Summary 
Rebalanced 
Enabled

Radio buttons used to determine if the Summary 
Rebalance feature is enabled in the Planning Portal.

Detail Level 
Enabled

Radio buttons used to determine if the Detail Level is 
enabled in the Planning Portal.

Auto Save 
Enabled

Radio buttons used to determine if the Auto Saving 
feature is enabled in the Planning Portal.

Key Description
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Section 12: Locale Configuration

The Locale Configuration feature enables you to configure any 
localization setting for both the Admin tool and the Planning Portal. You 
will be able to configure any label within both applications, images and 
symbols within the tool. It includes support for non english characters 
from any language for labels, dates, currency symbols and more.

When working with the locale configuration window you can tell which 
language you are working on by looking at the indicator in the lower left 
corner of the pane: 

Note: Before making any changes to the locale configuration for the 
Planning Portal please make sure nobody is accessing the Portal.

Note: If you are having problems viewing certain characters like currency 
symbols in foreign languages you might need to install the MUI 
(Multilingual User Interface) pack. You can find more information 
here: http://msdn.microsoft.com/en-us/goglobal/bb688178.aspx
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12-1: Editing Existing Languages

You can edit an existing language by clicking on it’s name. Make sure you 
choose the correct tool, languages under the Admin Tool will only affect 
this the Admin tool; if you wish to edit any labels or images for the 
Planning Portal select the appropriate language under the Planning 
Portal.
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1. Click on the Language name to edit miscellaneous settings like the 
decimal and currency symbol.

2. You can also change all the labels and images by expanding the 
language you wish to edit and go into the section you wish to change 
the Labels or images for. 

You can change a label by editing the “Contents” column, after you 
do so if you are editing a newly created language once you have 
changed the contents the Status column will change to “Translated” 
to indicate you have already translated that element. You can change 
the status of a whole tree section by right selecting the right one and 
right clicking on “Text” section under it and selecting the “Change 
Status Translated” this will set all keys in this group as translated.

You can also edit the images used by selecting the “Image” option 
under the node you are trying to edit.

Note: When changing any of the images remember the new images must 
be inside the folder where the Planning Portal was installed, this is 
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the default location: C:\Inetpub\wwwroot\PlanningPortal\, preferably 
put your images in the images folder:

3. After making all the necessary changes you can click the  button 
to save any changes, and after restarting IIS those changes will affect 
the Planning Portal.

12-2: Add a New Language

You can create new languages to use in both the Administration Tool and 
the Planning Portal itself. Make sure you choose the correct tool, 
languages under the Admin Tool will only affect this the Admin tool; if you 
wish to edit any labels or images for the Planning Portal select the 
appropriate language under the Planning Portal.

1. Click on the Planning Portal folder and click the  
button.
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2. The Add Language window will display. Select the language you wish 
to add into the tool from the “Select Language to Create” drop-down.

3. Select any language already in Planning Portal to use as a base for 
the new language.

4. Click the “Accept” button

5. After adding you new language it will show up in the list under the 
application for which you added the new language. Now you can start 
configuring your new language, for mor information see “Editing 
Existing Languages” on page 79.

12-3: Delete an Existing Language

You can delete languages created for both the Administration Tool and 
the Planning Portal itself. Make sure to select the correct tool from the 
Cultures tree in the left panel. Languages under the “Admin Tool” branch 
will only affect the language used in the Admin tool. If you wish to edit any 
labels or images for the Planning Portal, select the appropriate language 
under the “Planning Portal” branch of the tree. 

Note: The language en-US (English - United States) cannot be deleted for 
both the Admin Tool and the Planning Portal.

1. Click on the language you wish to remove and click the 

 button.
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2. A message box is displayed asking you to confirm the deletion. Click 
“Yes” to delete the currently selected language.

12-4: Images Locale

1. The tree structure for each language contains a listing of the screens 
available in the application. Expand the node and select the Images 
option.

The images available on the selected screen will display in the 
Localization Items panel to the right.
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2. Select the image from the Localization Items list. The corresponding 
item in other languages will display in the lower panel for reference.

3. Edit the images as necessary.

The table below details what each text box means.

Text Box Description

Key Description of the image.

Type Drop-down used to select if the image is a Local File or 
displayed from a URL.

Image Preview of the image.

4. The images are then saved in the following folder:

c:\inetpub\wwwroot\planningportal\images

5. Thereafter, you can add them in the Path text box.

A preview of the updated image automatically displays in the Image 
column.

Note: All Planning Portal applications must be closed when saving. Saving 
changes in the PP Admin Tool does not always refresh immediately 
in the Planning Portal. Please restart the Internet Information Server 
in order to ensure changes take effect.
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Section 13: Tools

This section describes certain features of the PP Admin Tool that are 
available under the Tools menu.

13-1: Restore Default Settings

This option will reset all settings in the PP Admin Tool to the originals, it 
will be as if you just installed the application and nothing had been 
customized.

Note: All system configurations will be lost when using this option, if you have 
not backed up your system configuration files it will not be possible to go 
back to your previous settings.

13-2: Import Locale Settings

If you had created a customized locale setting in a previous version of the 
PP, after upgrading you will be able to import it back into the application.

Locale setting includes configuration settings for labels, images and other 
settings related to language configuration in the PP.

Click the Browse button to locate your old “Locale.xml” file which should 
have been saved before un-installing the previous version of the PP. 

Click Import to save your changes.

Note: This version of the PP can upgrade configurations files from version 
3.6.04.26 and higher only; backup the current data and settings if you try 
to move to this version from any version lower than the mentioned above.
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13-3: Upgrade Tool

When performing an upgrade from older version you can reload all you 
old customized settings, Data Views, Field Views, User permissions and 
more using this tool.

Click browse to locate your old configuration files: Web.config and 
CustomSettings.xml. Then click upgrade to save your changes.

If you have changed the server hardware specifications in anyway you 
might get an invalid license error and will need to call in to get a new 
license. For more information on installing a license see 6-4: Planning 
Portal License36.

Note: This version of the PP can upgrade configurations files from version 
3.6.04.26 and higher only; backup the current data and settings if you try 
to move to this version from any version lower than the mentioned above.
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Chapter 4 Advanced Configuration

This chapter includes:
Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Section 2: Custom Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Section 3: Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Section 4: Data Filters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
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Section 6: Add-Ins. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Section 1: Overview

The Planning Portal Manager is located on the left-hand pane in the 
Planning Portal Admin Tool. The features listed in the PP Manager are 
used to configure users’ settings, Data Views, Field Views, Data Filters, 
Security access, and additional links. The sections in this chapter detail 
each feature, as well as how to configure each user’s access/privileges of 
the Planning Portal.

The depiction below is the Planning Portal Manager of the PP Admin 
Tool.
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Section 2: Custom Settings

2-1: Settings

The Settings feature enables you to configure the Planning Portal for 
users by accessing the tabs at the top of the window. The depiction below 
is an example of the Filter feature when clicking on Settings.

For more information on these tabs, please refer to Chapter 3: 
“Configuration” on page 51

2-2: Workflow Status

The Workflow feature allows users to communicate their status for the 
current forecast to others, as well as view the status of other users. This 
section of the admin tool is used to manage the different statuses 
available to users for the Workflow feature. The default status options are 
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“Initialized”, “In Progress”, and “Complete”. Any number of statuses can 
be added.

The “Icon if Late” and “Icon if Early” columns are used to select the icon 

that will display for workflow items with this Status in PP. Click the  
icon to select the graphic to use as the icon representing the Status.

2-2-1: Add a New Status

1. Click the  button.

A new empty row is added to the bottom of the list.

2. Enter a Name and change the Order column if it should precede any 
of the existing ones.

2-2-2: Edit an Existing Status

1. Change the Name or Order for the record you need to edit and click 

the  button to save your changes.
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2-2-3: Delete an Existing Status

1. Select the checkbox next to the name of the record you wish to delete 

and click the  button to remove it.

The selected Status is deleted immediately.

2-3: Workflow Tasks

The Workflow Tasks option allows you to create new processes for the 
workflow, as well as create the individual tasks in the process. Once the 
tasks have been created, they can be assigned a due date and then 
delegated to specific users..
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2-3-1: Creating a Process

1. Click the  button and a new process is added to the 
bottom of the tree. 

2. Enter a name for the new Process being created.

3. Click the  button. A new task is added to the process.

4. Enter a name for the task being added or click the drop-down arrow to 
select an existing task.
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5. In the Workflow Settings panel, enter a Description for the new task.

6. Select the Default Status for this task from the drop-down list. The 
default setting is “Initialized”, but you can select any Workflow Status 
to assign to this task.

7. In the User Settings table, use the check boxes in the Selected 
column to indicate the users being assigned to the task.

8. In the Cycle Management panel, use the “Number of Cycles” field to 
indicate the number of periods to add to this task.

9. Click the Add button. The current task is added to the grid below 
followed by the selected number of monthly periods.

10. The Start and End fields are used to select the range of periods that 
are displayed in the Cycle Management grid.

11. Click on the field for each period to select the due date for that task.

12. Click the Save button when finished to assign these tasks to the 
selected users.
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2-3-2: Clone an Existing Process

Cloning allows you to create a copy of an existing process or task to use 
as a base for a new process. By cloning, you can re-use an existing 
process without having to recreate it. Once cloned, you can make any 
necessary changes to the names, tasks, or due dates.

1. Select the process to clone from the tree.

2. Click the  button.

3. The Rename Entity window displays. Enter a name for the new 
process and click OK.

4. The new cloned process is added to the tree and can be modified as 
necessary.

2-3-3: Delete a Process

1. Select the process to delete from the tree.

2. Click the  button.

3. The selected process and any tasks contained within it are deleted 
and no longer display in the tree.
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2-4: Retag

This section of the Admin tools is used to setup Retag settings.

The table below details the types of configurations that can be used:

2-4-1: Add a Retag

1. Click the  button.

A new row is added to the bottom of the list.

2-4-2: Delete a Retag

1. Select the Delete checkbox next to the row to delete and click on the 

 button.

The row is deleted from the list.

Configuration Description

Name Name of Retag configuration used.

Description Defines the Retag configuration used.
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2-4-3: Edit a Retag

1. Click on the  button at the beginning of the row for the Retag 
you want to edit.

The edit window displays with the Options tab active.

2. Make edits as necessary. The tables below detail what each tab’s 
information means.

Table 4-1: Options tab

Option Code Description

REFCST Reforecast inside the retagging procedure.

CREATE_TARG
ET

Create a target series if one is non-existent.

CHK_SOURCE Check the reset flag consistency of the target item.

CHK_TARGET Check the remaining percentage consistency of the 
source.
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CREATE_TARG
ET_OBS

Create target observations if non-existent.

RUN_MODE Three options:
 UI only - User Interface
 Backend only - Backend
 Both - User Interface and Backend

SUPPORT_MAT
CHER

Support universal matcher.

DEBUG Provides a more detailed error message.

SRC_RCD_FLD Series field to record that the current series is a source.

TGT_RCD_FLD Series field to record that the current series is a target.

REFCST_FLD Series field to record that the current series needs to be 
reforecasted.

Table 4-2: Mapping Fields

Column Description

Retag Field Uneditable. QAD use only.

Engine Field Attributes linked.

Used Select if used in Retagging.

Source Field Reference purposes, if necessary.

Note Additional notes, if necessary.

Table 4-1: Options tab

Option Code Description
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3. On the Scenario Assignment tab, select which scenarios are to use 

this retag by clicking on the  icon.

Alternatively, click on the  icon to remove the scenario.

4. Click Close when finished.

2-5: Notes

Users have the ability to save notes in series while viewing their data with 
or without hierarchies. This section of the Admin tool has certain settings 
regarding the Notes feature in the PP.

Table 4-3: Opinion Lines

Column Description

OL Name References label name.

Engine Field Opinion Line

BK Engine Field Backup field for Retagging where data is saved.

Hist Future What Retagging affects:
 Historic
 Future
 Both (historic and future)

Note Additional notes, if necessary.
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2-5-1: General

This section contains general settings regarding the notes feature:

2-5-2: Reason Codes

Whenever users enter a note into the application there are several 
reasons why this note could have been added. In this section of the 
Admin Tool you can configure which reasons will be available for the 
notes feature. Reason codes can be useful for reporting types of notes 
entered at the series level such as customer information, promotion, 
product phase out, etc. Upon installation, the only reason available is 
“Default”, there is no limit to the number of reasons you can define.

2-5-3: Add a New Reason

1. Click the  button. 

A new empty row displays at the bottom of the list.

2. Enter a Reason Code.

2-5-4: Edit a Reason

1. Change the Reason Code for the record and click the Save button.

2-5-5: Delete a Reason

1. Enable the checkbox next to the Reason Code of the record you wish 

to delete and click on the  button to remove it.

Feature Description

Mandatory note 
entry before 
saving changes

When this option is enabled, all users logging into the 
PP will be required to enter a note whenever they make 
any changes to any data lines or attributes.
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Section 3: Views

3-1: Data Views

The Data Views feature defines which Opinion Lines are displayed and 
within which time frame. This section also defines if the data lines will be 
editable or read-only, the order in which they will be displayed and others.

The table below details the types of configurations that can be used:

You can expand the Data View using the  button to view which users 
have access to the Data View or manually assign it to users, for more 

Configuration Description

Name Determines the name of the configured View.

Description Defines View configuration.
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information on how to assign a Data View to users see “Assign Data View 
to Users” on page 105.

3-1-1: Add a Data View

1. Click the  button. 

A new row is added to the bottom of the list.

2. After you add the new bucket you can give the Data View a Name 
and a Description; after you this you can edit the newly created Data 
View, more information on how to edit a Data View can be found here 
“Edit a Data View” on page 102.

3-1-2: Delete a Data View

1. Select the Delete checkbox next to the Data View name and filter to 

delete and click the  button.

The selected Data View will be deleted from the list.
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3-1-3: Edit a Data View

1. Click on the  button for the record you want to edit.

The selected Data View window displays.

2. Select the fields to be used in Data View and click on the arrow. 

To remove fields to be used in Data View, click on the  arrow. 

To select all fields from the list, click on the  or  arrows.

3. Select the years to be displayed in Data View and click on the arrow.
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4. To remove the years to be used in Data View, click on the  

arrow. To select all years from the list, click on the  or  
arrows.

5. Click the  icon.

The Data View window is displayed.

6. Edit as necessary. The table below details each column.

Column Description

Field Opinion Line that is selected.

Label Description of Opinion Line. Changes to reflect display 
set aliases if a display set is selected.
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7. You can define the labels for each field manually by changing the 
Label column or you can use a Display Set to automatically populate 
the labels from the Display Set. Pick a Display Set from the drop 
down list and click on the Apply button, all the labels in the Data View 
will be replaced with the Aliases used in the selected Display Set.

Note: Display Set and Data Views are not synchronized, if any of the alias 
in the Display Set change after they have been applied to a Data 
View you will have to re apply them to the Data View in order to reflect 
the changes made to the Display Set.

8. Click Done when finished.

Visibility Determines if the display line is shown, Read-Only, or 
editable.

Order Determines in what order the Opinion Lines will be 
displayed in the PP grids.

DisplayGraph Determines if the Opinion Line displays in Graph View.

DisplaySummary Determines if the Opinion Line displays in Summary 
View.

Column Description
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3-1-4: Assign Data View to Users

After you have created your Data View you can choose which users will 

have access to it. You can expand the Data View using the  button to 
view which users have access the Data View as well as change each 
user’s access to the Data View.

If you would like to give all users access to the Data View, click the  
button under the Select column. Conversely, if you would like to remove 

all users access to the Data View, click the  button.

3-1-5: Copy Year Settings

Date Views must specify which opinion lines or data lines will be available 
and also a time frame, the specific years for which the data will be 
displayed; for example a Data View could display data for three years: 
2007, 2008 and 2009. If the year 2010 was to be added this would have 
been a manual process, the copy year feature allows to copy settings for 
a specific year, let’s say 2008 and use it to create settings for a new year 
like 2010.
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Click on the  button and the Add year in Data View 
window will be displayed

After this you need to pick the Source Year and Target Year from the 
drop down list. Enable the check box under the Add Year column next to 
the Data View you wish to add the settings for and click the Apply button.

In this example the “Demand Planner View” Data View will be changed, 
settings for year 2010 will be created using the settings for year 2009 as 
the template.
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3-2: Field Views

The Field Views feature defines which attributes display in different views. 
It is also where it is determined if they are editable, Read-Only, as well as 
in which views available.

The table below details the types of configurations that can be used:

You can expand the Field View using the  button to view which users 
have access to the Field View or manually assign it to users, for more 

Configuration Description

Name Determines which field is used in the Field View.

Description Defines the field used.
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information on how to assign a Field View to users see “Assign Field View 
to Users” on page 112 

3-2-1: Add a Field View

1. Click on the  button. 

A new Field View displays at the bottom of the list.

2. Enter a Name and optionally a Description for the new Field View; 
after you this you can edit the newly created Field View, more 
information on how to edit a Field View can be found here “Edit a 
Field View” on page 109
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3-2-2: Delete a Field View

1. Select the Delete checkbox next to the Field View name and filter and 

click the  button.

The selected Field View will be deleted from the list.

3-2-3: Edit a Field View

1. Click on the icon.

The selected Field View window displays.
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2. Select the fields to be used in Field View and click on the arrow. 

To remove fields to be used in Field View, click on the  arrow. 

To select all fields from the list, click on the  or  arrows.

3. Click the  button.

The Field View window displays.

4. Edit as necessary. The table below details each column.

Column Description

Field Attribute that is selected.

Label Description of Attribute. Changes to reflect display set 
aliases if a display set is selected.
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5. You can define the labels for each field manually by changing the 
Label column or you can use a Display Set to automatically populate 
the labels from the Display Set. Pick a Display Set from the drop 
down list and click on the Apply button, all the labels in the Field View 
will be replaced with the Aliases used in the selected Display Set.

Note: Display Set and Field Views are not synchronized, if any of the alias 
in the Display Set change after they have been applied to a Field 
View you will have to re apply them to the Field View in order to 
reflect the changes made to the Display Set.

6. Click Done when finished.

Visibility Determines if the attribute is shown, Read-Only, or 
editable.

Order Determines in what order the attributes are displayed 
in the PP grids.

Position Applies to Classic View. Determines where the 
attribute is displayed in relation to the data.

Note: The PP Admin Tool enables configuring the 
position of Field Views to the top, left, right and bottom. 
However, in Detail View, the Field View displays at the 
top only.

Column Description
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3-2-4: Assign Field View to Users

After you have created your Field Views you can choose which users will 

have access to it. You can expand each Field View using the  button 
to view which users have access the Field View as well as change each 
user’s access to the Field View.

If you would like to give all users access to the Field View, click the  
button under the Select column. Conversely, if you would like to remove 

all users access to the Field View, click the  button.
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Section 4: Data Filters

This section contains settings and configurations regarding Filters and 
Exceptions.

4-1: Filters

The Filters feature enables you to limit the displayed series with attributes 
that meet a defined criteria.

Note: Filters cannot be created or edited with the PP Admin Tool. Filters must 
be created in the DME Viewer or Planning Portal. 

You can expand the Filter using the  button to view which users 
have access to the it and manually assign it to users, for more information 
on how to assign a Data View to users see “Assign Data View to Users” 
on page 105

The table below details the columns that are displayed for each Filter:

Column Description

Name Determines the filter used in the data.

Description Defines the filter used.

Owner Defines the user who owns the filter.
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4-1-1: Assign Filter to Users

You can choose which users will have access to Filters; you can expand 

each Filter using the  button to view which users have access to it as 
well as change each user’s access to the Filter.

If you would like to give all users access to the Filter, click the  
button under the Select column. Conversely, if you would like to remove 

all users access to the Filter, click the  button.
Rev 1 114



Chapter 4
4-2: Exceptions

The Exceptions feature enables you to limit displayed series and to select 
series with observational data that meet a defined criteria. You must add 
Exceptions from the Viewer for users to be able to run Exceptions.

Note: Exceptions cannot be created or edited with the PP Admin Tool, they 
must be created in the DME Viewer.

The table below details the columns displayed for created exceptions:

Column Description

Name Determines the name of the Exception used.

Description Defines the Exception.

Owner Owner of this Exception.
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4-2-1: Assign Exceptions to Users

You can choose which users will have access to each Exception; you can 

expand each Exception using the  button to view which users have 
access to it as well as change each user’s access to the Exception.

If you would like to give all users access to the Exception, click the  
button under the Select column. Conversely, if you would like to remove 

all users access to the Exception, click the  button.
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Section 5: Security

5-1: Data Permissions

The Data Permissions feature grants specific privileges to users who are 
related to a specific scenario or fields within a scenario.

The table below details the types of configurations that can be used:

Note: A user can be assigned to one Data Permission only. If another Data 
Permission is assigned to a user, then the previous Data Permission 
is removed from that user.

Configuration Description

Name Name of Data Permission selected.

Description Description of selected Data Permission.
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You can expand the Data Permission row to edit the information. Each 
user has a User ID.

Note: It is highly recommended to specify which scenarios are visible. This 
is done in the Permission Definition in the DME Viewer.

5-2: Hierarchy Permission

This section of the Admin Tool is used to allow or restrict user’s access to 
hierarchies.

Note: Only hierarchies applied to scenarios that are available in the PP will be 
displayed in this section. 

Note: Only hierarchies that have been applied using the On-fly hierarchy 
options that contain a valid Base will be displayed. In order to create or 
recreate a valid base for a hierarchy, the owner of a scenario must log in 
to the scenario using the On-fly hierarchy options. Then select the 
“Recreate Base” check box in the DME Viewer using the hierarchy for 
which they want to recreate the Base.
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5-2-1: Assign Hierarchy to Users

You can choose which users will have access to each Hierarchy; you can 

expand each Hierarchy using the  button to view which users have 
access to it as well as change each user’s access to the Hierarchy.

If you would like to give all users access to the Hierarchy, click the  
button under the Select column. Conversely, if you would like to remove 

all users access to the Hierarchy, click the  button.

Note: Besides giving a user access to a hierarchy they will require access to the 
On Fly hierarchy permission, this can be assigned on the Hierarchy 
section on User Permission; for more information see l“Hierarchy” on 
page 125.
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5-3: User Security

The User Security feature enables you to determine each user’s User 
Name for both logging into the Planning Portal and Windows.

The table below details the types of configurations that can be used:

Configuration Description

User ID The User ID used for logging into Planning Portal.

NT Account The Username used for logging into Windows.
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5-4: License Generator

The License Generator generates a random serial number for the 
Planning Portal after you complete the installation. You must contact QAD
 for a valid License. Please see See “Planning Portal 
License” on page 36. for additional information.
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5-5: User Permission

This section is used to define access to different features within the 
Planning Portal.

5-5-1: Features

This section is used to assign access to the major features of the 
Planning Portal to each user.

Note: Certain Planning Portal features might not be available depending on the 
license type your company purchased.

The table below details which of the features will be available to each 
user, to give user access to a feature enable the checkbox for that user 
under the corresponding column:

Configuration Description

User ID Provides the user ID for the particular user.

Login Name Provides the user’s name when logging into the 
Planning Portal.

Last Name Displays the user’s last name.

First Name Displays the user’s first name.

Aggregate 
Report

Determines whether or not the user has access to the 
Aggregate Report feature.
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You can save your changes by clicking on the  button. You can also 

click on the  button to undo any changes.

5-5-2: User Workflow

The user workflow feature allows users to communicate the status of their 
forecasting process every step of the way. This section allows you to 
define what the visibility of those workflow changes will be for every user. 

New Item Link Determines whether or not the user has access to the 
New Item Link feature.

Mass Adjust Determines whether or not the user has access to the 
Mass Adjust feature.

Promo Determines whether or not the user has access to the 
Promotions feature.

Retag Determines whether or not the user has access to the 
Retag feature.

Profile Forecast Determines whether or not the user has access to the 
Profile Forecast feature.

Custom Task Determines whether or not the user will be able to run 
custom tasks from within the Planning Portal.

Configuration Description
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For example, managers will probably need to view the status for groups of 
people and regular users will only need to view their own changes.

The table below details the fields available on the Workflow definition 
screen:

Configuration Description

User ID Provides the user ID for the particular user.

Login ID Provides the user’s name for logging into the Planning 
Portal.

Last Name Displays the user’s last name.

First Name Displays the user’s first name.

Workflow Level The Workflow level is used to define what the visibility 
of the workflow status will be for each user. There are 
three different levels:

 All Users - Gives access to view the workflow 
status changes for all other users in the system.

 Self - Restricts access to only see a user’s own 
workflow status changes.

 Criteria - Restricts access to view workflow 
changes for all users of a certain type. A User Type 
must be specified in the Criteria column for this 
option.
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You can save your changes by clicking on the  button. You can click 

on the  button to undo any changes.

5-5-3: Hierarchy

This Section is used to give user’s access to using the different hierarchy 
types in the Planning Portal.

Criteria This field will only be enabled when the Workflow Level 
is set to Criteria. Here you can set which User Type the 
user will have access to. For example a user with a 
Criteria of “Sales Rep” will be able to view the workflow 
status changes for all users that belong to the “Sales 
Rep” type.

User Type This field will display the User Type to which the user 
belongs. The User Type can be set by editing the 
user’s information under the User Management section 
of the Base Unit.

Configuration Description
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The table below details which of the features will be available to each 
user, to give user access to a feature enable the checkbox for that user 
under the corresponding column:

Configuration Description

User ID Provides the user ID for the particular user.

Login ID Provides the user’s name for logging in to the Planning 
Portal.

Last Name Displays the user’s last name.

First Name Displays the user’s first name.

Hierarchy Static This permission will allow users to apply Static 
hierarchies inside the Planning Portal. Only the owner 
of a scenario will be able to apply or remove a static 
hierarchy in the Planning Portal.

Hierarchy On Fly This permission will allow users to apply On Fly 
hierarchies in the Planning Portal. Besides enabling 
this permission users should be assigned at least one 
hierarchy, for more information on assigning 
hierarchies see “Assign Hierarchy to Users” on 
page 119.
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Section 6: Add-Ins

6-1: Promo Ad Types

The Promo Ad Types feature is used to advertise for Promotions. In the 
Type code text box, you can type in up to 10 characters.

6-1-1: Add a Promo Type Code

1. Click on the  button. 

A new row is added to the bottom of the list.

6-1-2: Delete a Promo Type Code

1. Click on the Type code text box and click on the  
button.

The row is deleted from the list.
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6-2: Promo Mappings

The Promo Mappings feature is used to map Promotions to the database.

The table below details what each Field Name means. These field names 
are configured by your System Administrator.

Field Name Description

CD_SKU_CD Holds item information. Provides mapping between 
Promotions and the Atlas Planning Suite applications.

QY_WK_FCT_
BASELINE_ 
DMD

Determines which field you retrieve your forecast 
demand.

QY_WK_AMT
_BASELINE_
DMD

Determines which field you retrieve your actual 
demand.

AMT_FCT_ 
PRICE

Determines which field you retrieve your forecast price.
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AMT_FCT_ 
DISCOUNT_ 
PRICE

Determines which field provides your forecasted 
discount price.

AMT_FCT_ 
NET_PRICE

Determines which field provides your forecasted net 
price.

SKU_DESCRI
PTION

Definition of the Sku.

KY_CUSTOM
ER_CD

Customer ID.

COMMIT1 Determines if price is increased by number of units.

COMMIT2 Determines if price is increased by amount of unit.

DAYS_IN_ 
CYCLE

Determines the days in a cycle.

KEY_FIELD1 Provides additional information to make a series 
unique. (i.e., there may be more than one series.)

KEY_FIELD2 Provides additional information to make a series 
unique. (i.e., there may be more than one series.)

KEY_FIELD3 Provides additional information to make a series 
unique. (i.e., there may be more than one series.)

LINK_FIELD Provides the link between series table and Promotions 
table.

Field Name Description
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6-3: RSS Providers

The RSS Providers feature enables you to configure the PP by linking 
external web sites to the Home page. 

The table below details the types of configurations that can be used:

6-3-1: Add a Feed

1. Click on the  button. 

A new row is added to the bottom of the list.

Configuration Description

Name Provides the name of the URL to which the RSS 
Viewer is linked.

Feeds URL Provides the URL address for the website that is linked 
to the RSS Provider.
Rev 1 130



Chapter 4
6-3-2: Delete a Feed

1. Click on the Delete checkbox next to the filter and click on the 

 button.

The row is deleted from the list.
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